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Abstract. All articles must contain an abstract. The abstract text should be formatted using 10
point Times (or Times Roman, or Times New Roman) and indented 25 mm from the left
margin. Leave 10 mm space after the abstract before you begin the main text of your article.
The text of your article should start on the same page as the abstract. The abstract follows the
addresses and should give readers concise information about the content of the article and
indicate the main results obtained and conclusions drawn. As the abstract is not part of the text
it should be complete in itself, no table numbers, figure numbers, references or displayed
mathematical expressions should be included. It should be suitable for direct inclusion in
abstracting services and should not normally exceed 200 words. The abstract should generally
be restricted to a single paragraph. Since contemporary information-retrieval systems rely
heavily on the content of titles and abstracts to identify relevant articles in literature searches,
great care should be taken in constructing both.

1. Introduction

These guidelines, written in the style of a submission to J. Phys.. Conf. Ser., discuss how to prepare
your paper using Microsoft Word. In addition to the usual guidance on style/formatting, there are
notes and links to assist in using some of Word’s features such as inserting graphics, formatting
equations and so forth. A Word template is available for download from the Journal of Physics:
Conference Series web site. Follow the ‘Guidelines for authors’ link on http://jpcs.iop.org

2. Page layout (headers, footers, page numbers and margins)
If you don’t wish to use the Word template provided, please set the margins of your Word document
as follows.

e From the File menu select the Page Setup ... option to display the Page Setup dialog box.
o Seclect the paper size you want to use (US Letter or A4).
e Depending on the paper size you use, adjust the margin settings to those shown in table 1.

1 To whom any correspondence should be addressed.



Table 1. Setting Word’s margins for A4 and

US Letter paper.

Margin A4 US Letter
Top 4.0 cm 3.1cm
Bottom 2.7 cm 1.8 cm
Left 2.5 cm 2.8 cm
Right 2.5cm 2.8 cm
Gutter? 0cm 0 cm
Header? 0cm 0 cm
Footer? 0 cm 0 cm

@ These must be set to 0 cm. In addition, please
make sure the Mirror Margins option is not
selected.

2.1.1. Headers and footers

It is vital that you do not add any headers, footers or page numbers to your paper; these will be
added during the production process at IOP Publishing (this is why the Header and Footer margins are
set to 0 cm in table 1).

3. Formatting the title, authors and affiliations

In this section we discuss how to format the title, authors and affiliations. Please follow these
instructions as carefully as possible so all articles within a conference have the same style to the title
page. This paragraph follows a section title so it should not be indented.

3.1. Formatting the title

The title is set 17 point Times Bold, flush left, unjustified. The first letter of the title should be
capitalized with the rest in lower case. It should not be indented, as shown above. Leave 28 mm of
space above the title and 10 mm after the title. The easiest way to do this is to select Format >
Paragraph and set the ‘Spacing Before’ value to 28 mm and ‘Spacing After’ to 10 mm.

3.2. |[Formatting author names

The list of authors should be indented 25 mm to match the abstract. The style for the names is initials
then surname, with a comma after all but the last two names, which are separated by ‘and’. Initials
should not have full stops—for example A J Smith and not A. J. Smith. First names in full may be
used if desired. If an author has additional information to appear as a footnote, such as a permanent
address or to indicate that they are the corresponding author, the footnote should be entered after the
surname. However, before adding any footnotes please read appendix A ‘Inserting footnotes with
Microsoft Word’ for detailed notes and a complete example.

3.3. Formatting author affiliations

Please ensure that affiliations are as full and complete as possible and include the country. The
addresses of the authors’ affiliations follow the list of authors and should also be indented 25 mm to
match the abstract. If the authors are at different addresses, numbered superscripts should be used after
each surname to reference an author to his/her address. The numbered superscripts should not be
inserted using Word’s footnote command because this will place the reference in the wrong place—at
the bottom of the page (or end of the document) rather than next to the address. Ensure that any
numbered superscripts used to link author names and addresses start at 1 and continue on to the



number of affiliations. Do not add any footnotes until all the author names are linked to the addresses.
For example, to format

J Mucklow'3, J E Thomas'* and A J Cox??
where there are three addresses, you should insert numbered superscripts 1, 2 and 3 to link surnames

to addresses and then insert footnotes 4 and 5. Note that the first footnote in the main text will now be
number 6.

3.3.1. Inserting superscripts to link names and addresses.

e Type the appropriate superscript value just after the surname and just before the address:
J Mucklow2

2 Institute of Physics Publishing, Dirac House, Temple Back, Bristol BS1 6BE, UK

e Select each number in turn (here 2’) and do the following:

o Choose Format - Font to display Word’s ‘Font’ dialog box.
o Select ‘Superscript’ under the ‘Effects’ options.

o Click OK to apply the text formatting. You should see this:

J Mucklow?

2 IOP Publishing, Dirac House, Temple Back, Bristol BS1 6BE, UK

Repeat the procedure for all superscripted numbers. Please make sure that any footnotes within the
main text of your article continue on from any superscripted numbers used to link author names and

affiliations. For example, if you referred to two addresses the first proper footnote in the text would be
footnote 3.

3.3.2. An example. In this example we can see that there are footnotes after each author name and only
5 addresses; the 6th footnote might say, for example, ‘Author to whom any correspondence should be
addressed.’ In addition, acknowledgment of grants or funding, temporary addresses etc might also be
indicated by footnotes.

Spin dynamics in geometrically frustrated
antiferromagnetic pyrochlores

J S Gardner'>°, G Ehlers’, S T Bramwell* and B D Gaulin®

1 Physics Department, Brookhaven National Laboratory, Upton, NY 11973-5000, USA

2 NIST Center for Neutron Research, National Institute of Standards and Technology,
Gaithersburg, MD 20899-8562, USA

3 SNS Project, Oak Ridge National Laboratory, 701 Scarboro Road, Oak Ridge, TN 37830, USA
4 Department of Chemistry, University College London, 20 Gordon Street,

London WCI1H 0AJ, UK

3 Department of Physics and Astronomy, Canadian Institute for Advanced Research,

McMaster University, Hamilton, ON, L8S 4M1, Canada

4. Formatting the text
The text of your paper should be formatted as follows:



e 11 point ‘Times’ or ‘Times Roman’ or ‘Times New Roman’ depending on the fonts installed
on your computer.

o The text should be set to single line spacing.
Paragraphs should be justified.

e The first paragraph after a section or subsection should not be indented; subsequent
paragraphs should be indented by 5 mm.

5. Sections, subsections and subsubsections

The use of sections to divide the text of the paper is optional and left as a decision for the author.
Where the author wishes to divide the paper into sections the formatting shown in table 2 should be
used.

5.1. Style and spacing

Table 2. Formatting sections, subsections and subsubsections.

Font Spacing

Section 11 point Times bold 1 line space before a section
No additional space after a section heading

Subsection 11 point Times Italic 1 line space before a subsection
No space after a subsubsection heading

Subsubsection 11 point Times Italic Subsubsections should end with a full stop
(period) and run into the text of the paragraph

5.2. Numbering
Sections should be numbered as follows:

e sections should be numbered 1, 2, 3, etc
e subsections should be numbered 2.1, 2.2, 2.3, etc
e subsubsections should be numbered 2.3.1, 2.3.2, etc

with a dot following the number and then separated by a single space.

5.2.1. This is an example of a subsubsection. Note that the text for subsubsection headings should be
run into the text of the first paragraph.

6. Footnotes

Footnotes should be avoided whenever possible. If required they should be used only for brief notes
that do not fit conveniently into the text. Please read appendix A ‘Inserting footnotes with Microsoft
Word’ for guidelines on working with Word’s footnote facility.

7. Figures
Each figure should have a brief caption describing it and, if necessary, a key to interpret the various

lines and symbols on the figure.

7.1. Space considerations
Authors should try to make economical use of the space on the page; for example:

e avoid excessively large white space borders around your graphics;



e try to design illustrations that make good use of the available space—avoid unnecessarily
large amounts of white space within the graphic;

7.2. Text in figures
Wherever possible try to ensure that the size of the text in your figures (apart from
superscripts/subscripts) is approximately the same size as the main text (11 points).

7.3. Line thickness

In general, try to avoid extremely fine lines (often called ‘hairline’ thickness) because such lines often
do not reproduce well when printed out—your diagrams may lose vital information when downloaded
and printed by other researchers. Try to ensure that lines are no thinner than 0.25 pt. Note that some
illustrations may reduce line thickness when the graphic is imported and reduced in size (scaled down)
inside Microsoft Word.

7.4. Colour illustrations

You are free to use colour illustrations for the online version of Journal of Physics: Conference Series
but any print version will only be printed in black and white unless special arrangements have been
made with your conference organizer for colour printing. Please check with the conference
organizer whether or not this is the case. If any print version will be black and white only, you
should check your figure captions carefully and remove any reference to colour in the illustration and
text. In addition, some colour figures will degrade or suffer loss of information when converted to
black and white and this should be taken into account when preparing them.

7.5. Positioning figures

Individual figures should normally be centred but place two figures side-by-side if they will fit
comfortably like this as it saves space. Place the figure as close as possible after the point where it is
first referenced in the text. If there are a large number of figures it might be necessary to place some
before their text citation. Figures should never appear within or after the reference list.

7.6. Figure captions/numbering
Captions should be below the figure and separated from it by a distance of 6 points—although to save
space it is acceptable to put the caption next to the figure. Figures should be numbered sequentially
through the text—‘Figure 1°, ‘Figure 2’ and so forth and should be referenced in the text as ‘figure 1°,
“figure 2°,... and not ‘fig. 1°, ‘fig. 2, ....

For captions not placed at the side of the figure, captions should be set to the width of the figure for
wider figures, centred across the width of the figure, or, for narrow figures with wide captions, slightly
extended beyond the width of the figure. The caption should finish with a full stop (period).

7.6.1. How to format figures and captions. One of the easiest ways to format a figure and the
corresponding caption is to place the figure and caption in a table containing one column and two
rows; place the graphic in the top row and the caption in the bottom row. To format the figure/table
combination, you can adjust the width of the table, centre the table and adjust the width of the rows to
give the appropriate layout.

7.6.2. Examples. The following examples show how to format a number of different figure/caption
combinations. Note that the table borders are shown as broken lines for guidance only; they
should not, of course, be shown in your actual paper.

o Figure with a short (narrow) caption. Centre the table and centre the caption and figure inside
each table cell.



Wider figure/short caption

Figure 3. Figure with short caption (caption centred).

e Narrow figure/wide caption. To save space on the page put the caption to the right of the
figure as shown. To do this place the graphic and its caption in a table with one row and two
columns. Justify the caption.

Narrow
figure
with a
wide

Figure 4. This is a figure with a caption that is

< wider than the actual graphic. To save space you
Captlon' can put the caption to the right of the figure by
placing the graphic and justified caption in a table

with one row and two columns.

e Wider figure/wider caption. This is a figure with a caption as wide as the actual graphic. In
this case simply justify the caption across the width of the graphic.

Wider figure/wider caption

Figure 5. In this case simply justify the caption so that it is as the
same width as the graphic.

7.6.3. Side-by-side figures. Where possible, try to place figures side-by-side to reduce the amount of
space used. Use a table to do this. For example, to put two figures side-by-side create a table with
three columns and two rows. Make the middle column narrow to provide some space between the



graphics, as shown below. Note that the table borders are shown as broken lines for guidance
only; they should not, of course, be shown in your actual paper.

Narrow Narrow
figure figure
with a with a
wide wide
caption. caption.

Figure 1. These two figures Figure 2. These two figures
have been placed side-by-side have been placed side-by-side
to save space. Justify the to save space. Justify the
caption. caption.

7.7. Figures in parts
If a figure has parts these should be labelled as (a), (b), (c) etc on the actual figure. Parts should not
have separate captions.

8. Tables
Note that as a general principle, for large tables font sizes can be reduced to make the table fit on a
page or fit to the width of the text.

8.1. Positioning tables
Tables should be centred unless they occupy the full width of the text.

8.2. Tables in parts
If a table is divided into parts these should be labelled (a), (b), (c) etc but there should only be one
caption for the whole table, not separate ones for each part.

8.3. Table captions/numbering

Tables should be numbered sequentially throughout the text and referred to in the text by number
(table 1, not tab. 1 etc). Captions should be placed at the top of the table and should have a full stop
(period) at the end. Except for very narrow tables with a wide caption (see examples below) the
caption should be the same width as the table. Note, to set captions to be the same width as the table,
one convenient method is to place the caption inside a row at the top of the table and merge (combine)
the cells together so that you have a single table cell the width of the table (select the row to contain
the caption and do Table—> Merge Cells).

8.4. Rules in tables



Tables should have only horizontal rules and no vertical ones. Generally, only three rules should be
used: one at the top of the table, one at the bottom, and one to separate the entries from the column
headings. Table rules should be 0.5 points wide.

8.5. Examples
Because tables can take many forms, it is difficult to provide detailed guidelines; however, the
following examples demonstrate our preferred styles.

8.5.1. A simple table. The following example is a simple, narrow table. Here we extend the caption
text outside the width of the table.

Table 3. A simple table. Place the caption above the
table. Here the caption is wider than the table so we
extend it slightly outside the width of the table. Justify
the text. Leave 6 pt of space between the caption and the
top of the table.

Distance (m) Velocity (ms™)
100 23.56
150 34.64
200 23.76
250 279

8.5.2. A more complex table. The following is a slightly more complex table with a caption that is
narrower than the table. Centre the caption across the width of the table. If it is difficult to make a
table fit the page, use a smaller font. Headings should normally be in Roman (i.e., not bold or italic)
type, have an initial capital and normally align left (but centred sometimes looks better); it is up to the
author to choose a layout that is most useful to the reader. Columns of numbers normally align on the
decimal point and it is quite possible to do this in Word using a “decimal tab”; however we will not
describe this here—details may be found in Word’s help facility.

Table 4. A slightly more complex table with a narrow caption.

Wake ChiSqr.  p  Stage 1 ChiSqr. p Stage 2 Chi Sqr. P

(N=15, df=1) (N=15, df=1) (N=15, df=1)
F3 1.143 0.285 0.286 0.593 0.286 0.593
Fz 1.143 0.285 0.067 0.796 0.067 0.796
F4 4.571 0.033 1.667 0.197 1.143 0.285
C3 0.286 0.593 0.067 0.796 0.067 0.796
Cz 1.143 0.285 0.077 0.782 0.286 0.593
C4 2.571 0.109 0.600 0.439 1.667 0.197
P3 0.000 1.000 0.600 0.439 0.600 0.439
Pz 0.286 0.593 1.143 0.285 0.286 0.593

P4 0.286 0.593 0.000 1.000 0.067 0.796




Table 5. A slightly more complex table with a caption that is the same width as
the table. Simply place the caption inside a row at the top of the table and merge
(combine) the cells together so that you have a single table cell the width of the
table (select the row to contain the caption and do Table-> Merge Cells). Justify
the caption.

Wake ChiSqr. p  Stage 1 ChiSqr. p Stage 2 Chi Sqr. p
(NV=15, df=1) (N=15, df=1) (N=15, df=1)
F3 1.143 0.285 0.286 0.593 0.286 0.593
Fz 1.143 0.285 0.067 0.796 0.067 0.796
F4 4.571 0.033 1.667 0.197 1.143 0.285
C3 0.286 0.593 0.067 0.796 0.067 0.796
Cz 1.143 0.285 0.077 0.782 0.286 0.593
C4 2.571 0.109 0.600 0.439 1.667 0.197
P3 0.000 1.000 0.600 0.439 0.600 0.439
Pz 0.286 0.593 1.143 0.285 0.286 0.593
P4 0.286 0.593 0.000 1.000 0.067 0.796

8.6. Notes to tables

If you wish to format a table so that it contains notes (table footnotes) to the entries within the body of
the table and/or within the table caption, these notes should be formatted using alphabetic superscripts
such as 2, ®, ¢ and so forth. Notes within the table caption should be listed first. Notes should be placed
at the bottom of the table; one convenient method is to create an empty row at the bottom of the table
to contain them. Again, merge the cells to give you a single cell the width of the table. Table notes
should be 10 point Times Roman. Each note should be on a separate line.

Table 6. A table with headings spanning two columns and containing notes®.

Thickness Separation energies
Nucleus (mg cm?) Composition v, n (MeV) Y, 2n (MeV)
181Ta 19.3+0.1° Natural 7.6 14.2
208pp 3.8+0.8¢ 99% enriched 7.4 14.1
209Bi 2.6+0.01°¢ Natural 7.5 14.4

# Notes are referenced using alpha superscripts.
b Self-supporting.
¢ Deposited over Al backing.

9. Equations and mathematics

9.1. Fonts in Equation Editor (or MathType)
Make sure that your Equation Editor or MathType fonts, including sizes, are set up to match the text of
your document.

9.2. Points of style



9.2.1. Vectors. Bold italic characters is our preferred style but the author may use any standard
notation; for example, any of these styles for vectors is acceptable:

‘the vector cross product of @ and b is given by axb...”, or
‘the vector cross product of a and b is given by axb...’, or

‘the vector cross product of @ and bis given by a x b.. .

9.2.2. The solidus (‘/’). A two-line solidus should be avoided where possible; for example, use

2\‘1 2
LU.mda)&J instead of 1/Iooda)|S°|
M, |70 N M./ ¢ N

2 2\ ¥2 2 2
(X +y ) instead of (u\
L X+y ) X+y J

9.2.3. Roman and italic in mathematics. Variables should be in italic; however there are some cases
where it is better to use a Roman font:

e Use a Roman d for a differential d, for example, tand =dy/dx.
e Use a Roman e for an exponential e; for example, y=e”.

e Use a Roman i for the square root of —1; e.g., i= J-1.

e Certain other common mathematical functions, such as cos, sin, det and ker, should appear in
Roman type.

e  Subscripts and superscripts should be in Roman type if they are labels rather than variables or
characters that take values. For example in the equation

£, = —8M,Bm

m, the z component of the nuclear spin, is italic because it can have different values whereas n
is Roman because it is a label meaning nuclear.

9.3. Alignment of mathematics
The preferred style for displayed mathematics in Journal of Physics: Conference Series is to centre
equations; however, long equations that will not fit on one line, or need to be continued on subsequent
lines, should start flush left. Any continuation lines in such equations should be indented by 25 mm.
Equations should be split at mathematically sound points, often immediately before =, + or — signs
or between terms multiplied together. The connecting signs are not repeated and appear only at the
beginning of the turned-over line. A multiplication sign should be added to the start of turned-over
lines where the break is between two multiplied terms.

9.3.1. Small displayed equations: Some examples:

4. =(27)"" expik-7| (1)

A(3/2) — A(*) —A(i) (I = %) )



C(12) = [ﬁ(x) . g?ﬁ(x +r)]

2 L
zl—constZ—ZJ.%Jr--- 3)

r

r’ L
zl—const—zln — |+
L r

However, if equations will fit on one line, do so; for example, (5) may also be formatted as:
2 L 2
-~ r° ¢ xdx L
C(12)=| z(x)-¢(x+7) |~ 1—const— —+---~1—const—1n[ j+ 6
(12) =[#(x)- g(x-+7) zl i~ ©)

9.3.2. Large display equations: examples. If an equation is almost the width of a line, place it flush left
against the margin to allow room for the equation number.

Yowy L (hv) N e — )] E -
q[(hv) (hv) ] +(hAa)l/2) (hv) Er-Ey A¢[E+(E —E )]/ exp[(E—-E )/kT]+1
/2
/2 | cos (@) cos@ cos (@) s1n\/_ 4 2 cos \/_n(p
l-g dg0:ir1_q Jr(l—q) i{cos@(gp)} l1-¢g
?p sinf(@) sin \/ZW) Jhn sin &(p) cos\/_ 4 . dg [sindg) sin \/_n(o
I-q I-q ]|,
B

0 h
(1 —q)2 @/ | cos@(¢p)cos \/:nq(p
+hi— [ do. (8)

hnp
q

P8 |sinf(¢)sin "

9.4. Miscellaneous points
e Exponential expressions, especially those containing subscripts or superscripts, are clearer if

the notation exp(...) is used, except for simple examples. For instance, exp[i(kx— a)t)] and

i(kr—ot)

exp(zz) are preferred to e and ezz, but e’is acceptable. Similarly the square root sign

V' should only be used with relatively simple expressions, e.g. V2 and Vd? +b°, but in
other cases the power 1/2 should be used.
e [t is important to distinguish between In =log, and lg = log,,,.

e Braces, brackets and parentheses should be used in the following order: {[()]}. The same
ordering of brackets should be used within each size. However, this ordering can be ignored if
the brackets have a special meaning (e.g. if they denote an average or a function).

e Decimal fractions should always be preceded by a zero: for example 0.123 not .123 (note, do
not use commas, use the decimal point).

e Equations that are referred to in the text should be numbered with the number on the right-
hand side.



9.5. Equation numbering

Equations may be numbered sequentially throughout the text (i.e., (1), (2), (3),...) or numbered by
section (i.e., (1.1), (1.2), (2.1) ,...) depending on the author’s personal preference. In articles with
several appendices equation numbering by section is useful in the appendices even when sequential
numbering has been used throughout the main body of the text: for example, A.1, A.2 and so forth.
When referring to an equation in the text, always put the equation number in brackets—e.g. ‘as in
equation (2)’ or ‘as in equation (2.1)’—and always spell out the word ‘equation’ in full, e.g. ‘if
equation (5) is factorized’; do not use abbreviations such as ‘eqn.” or ‘eq.’.

10. Appendices
Technical detail that it is necessary to include, but that interrupts the flow of the article, may be
consigned to an appendix. Any appendices should be included at the end of the main text of the paper,
after the acknowledgments section (if any) but before the reference list. If there are two or more
appendices they should be called appendix A, appendix B, etc.

Numbered equations should be in the form (A.1), (A.2), etc, figures should appear as figure Al,
figure B1, etc and tables as table Al, table B1, etc.

11. References
As part of the production system for Journal of Physics: Conference Series, online versions of all
reference lists will, wherever possible, be linked electronically using IOP Publishing’s HyperCite™
technology. Consequently, it vitally important for all the references to be accurate and to be carefully
formatted using the guidelines below, enabling your paper to be available online with the minimum of
delay.

A complete reference should provide the reader with enough information to locate the article
concerned, whether published in print or electronic form, and should, depending on the type of
reference, consist of:

name(s) and initials;

date published;

title of journal, book or other publication;

titles of journal articles may also be included (optional);
volume number;

editors, if any;

town of publication and publisher in parentheses for books;
the page numbers.

Two different styles of referencing are in common use: the Harvard alphabetical system and the
Vancouver numerical system. For Journal of Physics: Conference Series, please use the Vancouver
numerical system as described below.

11.1. Numerical system

In the numerical system references are numbered sequentially throughout the text. The numbers occur
within square brackets, like this [2], and one number can be used to designate several references. The
reference list gives the references in numerical, not alphabetical, order.

11.1.1. References to printed journal articles. A normal reference to a journal article contains three
changes of font (see table 6).

Points to note



e There should be a 5 mm gap between the reference number (e.g., ‘[8]") and the start of the
reference text. Second and subsequent lines of individual references should be indented by
5 mm. For example:

[1]  Aderhold J, Davydov V Yu, Fedler F, Klausing H, Mistele D, Rotter T, Semchinova O,
Stemmer J and Graul J 2001 J. Cryst. Growth 222 701

o the authors should be in the form surname (with only the first letter capitalized) followed by
the initials with no periods after the initials. Authors should be separated by a comma except
for the last two which should be separated by ‘and’ with no comma preceding it.

o The article title (if given) should be in lower case letters, except for an initial capital, and
should follow the date.

o The journal title is in italic and is abbreviated. If a journal has several parts denoted by
different letters the part letter should be inserted after the journal in Roman type, e.g. Phys.
Rev. A.

o Both the initial and final page numbers should be given where possible. The final page
number should be in the shortest possible form and separated from the initial page number by
an en rule ‘- “, e.g. 1203—14, i.e. the numbers ‘12’ are not repeated.

Table 6. Font styles for a reference to a journal article.

Element Style
Authors Roman type
Date Roman type
Article title (optional) Roman type
Journal title Italic type
Volume number Bold type
Page numbers Roman type

Here are some examples taken from published papers:

[1]  Strite S and Morkoc H 1992 J. Vac. Sci. Technol. B 10 1237

[2] Jain S C, Willander M, Narayan J and van Overstraeten R 2000 J. App!. Phys. 87 965

[3] Nakamura S, Senoh M, Nagahama S, Iwase N, Yamada T, Matsushita T, Kiyoku H and
Sugimoto Y 1996 Japan. J. Appl. Phys. 35 L74

[4] Akasaki I, Sota S, Sakai H, Tanaka T, Koike M and Amano H 1996 Electron. Lett. 32 1105

[5] O’Leary S K, Foutz B E, Shur M S, Bhapkar U V and Eastman L F 1998 J. Appl. Phys. 83 826

[6] QianZ G, Shen W Z, Ogawa H and Guo Q X 2002 J. Appl. Phys. 92 3683

[7] Guo Q X, Okada A, Kidera H, Tanaka T, Nishio M and Ogawa H 2002 J. Cryst. Growth 237—
239 1032

[8] Aderhold J, Davydov V Yu, Fedler F, Klausing H, Mistele D, Rotter T, Semchinova O,
Stemmer J and Graul J 2001 J. Cryst. Growth 222 701

[9] Mamutin V, Veskin V, Davydov V, Ratnikov V, Shubina T, Inanov S, Kopev P, Karlsteen M,
Soderwall U and Willander M 1999 Phys. Status Solidi 176 247

[10] Jenkins D W and Dow J D 1989 Phys. Rev. B 39 3317

[12] Tansley T L and Egan R J 1992 Phys. Rev. B 45 10942

[13] Wessel R, Koch C and Gabbiani F 1996 Coding of time-varying electric field amplitude
modulations in a wave-type electric fish J. Neurophysiol. 75 2280-93



11.1.2. References to preprints. For preprints there are two distinct cases:

1. Where the article has been published in a journal and the preprint is supplementary reference
information. In this case it should be presented as:

[1] Kunze K 2003 T-duality and Penrose limits of spatially homogeneous and inhomogeneous
cosmologies Phys. Rev. D 68 063517 (Preprint gr-qc/0303038)

2. Where the only reference available is the preprint. In this case it should be presented as

[1] Milson R, Coley A, Pravda V and Pravdova A 2004 Alignment and algebraically special tensors
Preprint gr-qc/0401010

11.1.3. References to electronic-only journals. In general article numbers are given, and no page
ranges, as most electronic-only journals start each article on page 1.

e For New Journal of Physics (article number may have from one to three digits)

[1]  Fischer R 2004 Bayesian group analysis of plasma-enhanced chemical vapour deposition data
New. J. Phys. 6 25

e For SISSA journals the volume is divided into monthly issues and these form part of the
article number

[1] Horowitz G T and Maldacena J 2004 The black hole final state J. High Energy Phys.
JHEP02(2004)008

[2] Bentivegna E, Bonanno A and Reuter M 2004 Confronting the IR fixed point cosmology with
high-redshift observations J. Cosmol. Astropart. Phys. JCAP01(2004)001

11.1.4. References to books, conference proceedings and reports. References to books, proceedings
and reports are similar to journal references, but have only two changes of font (see table 7).

Table 7. Font styles for references to books, conference
proceedings and reports.

Element Style
Authors Roman type
Date Roman type
Book title Italic type
Editors Roman type
Place (city, town etc) of Roman type
publication

Publisher Roman type
Volume Roman type
Page number(s) Roman type

Points to note



e Book titles are in italic and should be spelt out in full with initial capital letters for all except
minor words. Words such as Proceedings, Symposium, International, Conference, Second, etc
should be abbreviated to Proc., Symp., Int., Conf., 2nd, respectively, but the rest of the title
should be given in full, followed by the date of the conference and the town or city where the
conference was held. For Laboratory Reports the Laboratory should be spelt out wherever
possible, e.g. Argonne National Laboratory Report.

e The volume number, for example vol 2, should be followed by the editors, if any, in a form
such as ‘ed A J Smith and P R Jones’. Use ef al if there are more than two editors. Next comes
the town of publication and publisher, within brackets and separated by a colon, and finally
the page numbers preceded by p if only one number is given or pp if both the initial and final
numbers are given.

Examples taken from published papers:

[1] Kurata M 1982 Numerical Analysis for Semiconductor Devices (Lexington, MA: Heath)

[2]  Selberherr S 1984 Analysis and Simulation of Semiconductor Devices (Berlin: Springer)

[3] Sze SM 1969 Physics of Semiconductor Devices (New York: Wiley—Interscience)

[4] Dorman L 1 1975 Variations of Galactic Cosmic Rays (Moscow: Moscow State University
Press) p 103

[5] Caplar R and Kulisic P 1973 Proc. Int. Conf. on Nuclear Physics (Munich) vol 1 (Amsterdam:
North-Holland/American Elsevier) p 517

[6] Cheng G X 2001 Raman and Brillouin Scattering—Principles and Applications (Beijing:
Scientific)

[7] Szytula A and Leciejewicz J 1989 Handbook on the Physics and Chemistry of Rare Earths vol
12, ed K A Gschneidner Jr and L Erwin (Amsterdam: Elsevier) p 133

[8] Kuhn T 1998 Density matrix theory of coherent ultrafast dynamics Theory of Transport
Properties of Semiconductor Nanostructures (Electronic Materials vol 4) ed E Scholl
(London: Chapman and Hall) chapter 6 pp 173-214

[9] Kuhn T, Binder E, Rossi F, Lohner A, Rick K, Leisching P, Leitenstorfer A, Elsaesser T and
Stolz W 1994 Coherent excitonic and free-carrier dynamics in bulk GaAs and
heterostructures Coherent Optical Interactions in Semiconductors: Proc. NATO Advanced
Research Workgroup (Cambridge, UK, 11-14 August 1993) (NATO Advanced Study
Institute, Series B: Physics vol 330) ed R T Phillips (New York: Plenum) pp 33-62

11.2. Reference lists
Up to ten authors may be given in a particular reference; where there are more than ten only the first
should be given followed by et al.

Abbreviations of the names of periodicals used by IOP Publishing are usually the same as those
given in British Standard BS 4148: 1985. If an author is unsure of an abbreviation it is best to leave
the title in full. The terms loc. cit. and ibid should not be used.

Unpublished conferences and reports should generally not be included in the reference list and
articles in the course of publication should be entered only if the journal of publication is known. A
thesis submitted for a higher degree may be included in the reference list if it has not been superseded
by a published paper and is available through a library; sufficient information should be given for it to
be traced readily.

12. Cross referencing

e References. References should be cited in the text using square brackets; for example, ‘[3]’.
e Figures. Figures should be referenced in the text as ‘figure 1°, ‘figure 2’ etc.
e Tables. Tables should be referenced as ‘table 1°, ‘table 2’ etc.



o Sections, subsections and subsubsections. For example ‘section 3.1° not ‘sec. 3.1°.

e FEquations. Equations references should contain the equation number in parentheses, such as
(3.1). Note that it is not normally necessary to include the word ‘equation’ before an equation
number except where the number starts a sentence. The word ‘equation’ should not be
abbreviated.
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Appendix A. Inserting footnotes with Microsoft Word
Suppose you need to format an author list as follows:

J Mucklow'#, J E Thomas?® and A J Cox>°

where superscripts 1, 2 and 3 refer to addresses and superscripts 4 and 5 are to provide further
information, via footnotes, such as to indicate the corresponding author (4) and details of research
funding (5). So, we need to have the first footnote as number 4. Fortunately, Word allows you to set
the number at which footnotes start.

From the Insert menu option, select Reference (or the equivalent option if you are not using Word
XP) to display a dialog box that controls the insertion of footnotes and endnotes:

Footnote and Endnote @E|
Location
(¥ Footnotes: |EI:|1.'|IIIT| of page j
" Endnotes: | J
Convert...
Format
Mumber format: | 1, 2, 3, ... ﬂ
Custom mark: Symbal. ..
Start at: B2
Mumbering: | Continuous ﬂ
Apply changes
Apply changes to: |whole document = |
Insert | Cancel | Apply |

Because we need the first footnote to start at 4, type ‘4’ in the ‘Start at:’ text box as shown above.
Click Apply to restart the numbering.



